For more information on the Outlier Test, see Outlier Test, p. 147.

Chapter Eight    Method Validation

1. Method Validation Overview

The Method Validation software tests the variance and the linearity of the data. It also determines performance characteristics according to the requirements of DIN 38402-Part 51.

For method validation according to DIN regulations, follow these steps:

1. Select the estimated working range.

2. Prepare 10 calibration standards, with concentrations distributed uniformly over the complete working range.

3. Create a sample table, with 10 injections of the highest and lowest standard concentrations and a single injection for all other standards. If more than one injection is made of the intermediate standards, the linearity test is calculated with the results of the first replicates only.

4. Analyze these standards. The results are saved in a .cal/file.

5. Select Method Validation from the TOC Control Validation menu, or select DIN 38402 from the Tocontr program folder. The Method Validation screen appears.

6. From the Options menu, ensure that Validation Strictly Following DIN is enabled. If not, select the menu item.

7. Select Open from the File menu.

8. Select .cal from the file type drop-down list.

9. From the File Name list, select the .cal/file where the measurement data was saved. Then select OK.

10. The calculations are automatically performed, and the validation data displayed.
11. Select Save from the File menu, assign a file name in the Save As dialog box, and select OK. The validation data is saved with a .val file name extension.

**Note:** When the actual calibration function doesn't meet the DIN specification, check the instrument for system errors, or reduce the working range, then repeat the Validation.

For details, refer to the TOC 5000 / TOC 5050 instruction manual, shipped with the instrument.

2. **File Menu**

Select the directory where the desired file is located.
Select the type of file desired from the drop-down list. The available file types are listed below (identified by file name extension):

- **.val**
  - .val files are created by the DIN38402 program. They contain results of validation calculations performed on data.

- **.cal**
  - .cal data files are created by the TOC Control program. When these files are opened by the DIN38402 program, validation calculations are performed automatically.

Select the desired file from the list of file names that appears.
Click OK.
Save
Choose Save to save the displayed data in a previously-named file. If the file has not been saved previously, the Save As dialog box opens.

Save As
Choose Save As to save the current data under a new file name or location. File type is determined automatically.

Print
Select Print to print the displayed data according to the Print Options dialog box specifications (in the Options menu).

Printer Setup
Select Printer Setup to display the Printer Setup dialog box. Options vary according to the system printer.

Close
Choose Close to exit the DIN38402 program.

3. Validation Menu
Several charts and tables are available for viewing in the Validation program. Select desired items from this menu.

Datasheet
Measurement results of all samples and their replicates are displayed in the table. When Validation Strictly Following DIN is enabled (Options menu), only the first replicate of each sample is used for computing the linearity test and calibration function. In that case, the unused replicates are displayed over a light blue background color.

<table>
<thead>
<tr>
<th>Sample</th>
<th>replicate</th>
<th>X (mm)</th>
<th>Y1</th>
<th>Y2</th>
<th>Y3</th>
<th>Y4</th>
<th>Y5</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1.000</td>
<td>30.000</td>
<td>42.00</td>
<td>32.00</td>
<td>23.00</td>
<td>14.00</td>
<td>5.00</td>
</tr>
<tr>
<td>2</td>
<td>1.500</td>
<td>25.000</td>
<td>48.00</td>
<td>36.00</td>
<td>27.00</td>
<td>18.00</td>
<td>6.00</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
</tbody>
</table>

The Complete data sheet

Linearity
Calculated results of the linearity test are displayed in this spreadsheet.

On the left are the results of the linear regression calculation; on the right, the corresponding results of the quadratic calibration are displayed. The footer displays the comparison between these two calculation methods.

Complete
All the information represented by the five menu items below this command is displayed.
Method Validation

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y (response)</td>
<td>290.76972</td>
</tr>
<tr>
<td>Intercept (b)</td>
<td>-209.60333</td>
</tr>
<tr>
<td>Residual SD (Sy)</td>
<td>177.34517</td>
</tr>
<tr>
<td>Process SD (Sx)</td>
<td>0.24945</td>
</tr>
<tr>
<td>CV (Y)</td>
<td>0.6816</td>
</tr>
<tr>
<td>Coeff. of Correlation (r²)</td>
<td>0.9399902</td>
</tr>
<tr>
<td>Lower limit of determination (95%)</td>
<td>1.507962</td>
</tr>
<tr>
<td>Difference between variances (CV)</td>
<td>1.4867705</td>
</tr>
<tr>
<td>Test value (t)</td>
<td>0.12791</td>
</tr>
<tr>
<td>Value t from t-table</td>
<td>12.3000</td>
</tr>
</tbody>
</table>

The difference between variance (CV²) and (CV²) is not significant.

The calibration function may be regarded as linear in the working range.

Homogeneity of Variance

The replicates used, and the results of the homogeneity of variance test, are displayed in this spreadsheet.

Residual Analysis

This graph displays the deviations of the calibration points from the calculated linear regression curve. It is used to determine whether there is an outlier in the data or if there is a significant problem over the working range of the calibration.

The Residual Analysis dataset

Calibration Function

This graph displays the linear regression of the calibration curve, as well as the levels of confidence above and below the calibration curve. This graph can be customized; see p. 142 for more information.

The Calibration function

4. Options Menu

The Options menu items are used to set parameters for different features of the program.
Method Validation

General Parameters
The General Parameters dialog box appears, where general information about the current file is displayed. A title and comment can be entered, if desired.

File Name
Displays the name of the file where the Validation results are stored.

Sample Run
Displays the name of the file where the data for the validation calculations are stored.

Date / Time
Displays the date and time of the validation.

Unit
Displays the analysis unit of measurement (ppb, ppm, etc.).

Analysis Type
Displays the analysis method (TC, IC, etc.) of the injections.

Title
Enter a title, if desired.

Comment
Enter comments, if desired.
Press OK to save the entries, or press Cancel to exit the dialog box without saving.

Display Font
Opens the Font dialog box to customize the on-screen fonts.

Display Options
Define the precision of the X- and Y-values, and change the X- and Y-axis titles.

File Export Options
Enables the user to select items of information to be exported to an ASCII file.
Method Validation

![Image]

The File Export Options dialog box

In the Separator drop down list, select the character for separating items in the ASCII file: space, tab, comma, or semicolon.

Print Options
Designate the items to be printed.

![Image]

The Print Options dialog box

Recalculation
Select this item to recalculate all results of the current Validation.

Validation strictly following DIN
When enabled, the validation calculation strictly follows DIN 38402 requirements, i.e., only the first injection of every standard is used for calibration (except for the first and last standards, which are averaged). Otherwise, the mean value of all area counts is used for calculating the calibration.

Save Settings on Exit
When enabled, the display parameters are saved.

5. Help Menu

Content
Opens the table of contents of the help file.

About
Displays version number and registration information.

6. Calculations

The following is a list of calculations performed by the Validation program.

Checking the Homogeneity of Variance
For both points under consideration, the variances are calculated using the following equations:

\[
s_1^2 = \frac{\sum_{i=1}^{n_1} (y_i - \bar{y}_1)^2}{n_1 - 1}
\]

where:

\[
y_i = \frac{\sum_{i=1}^{n_1} y_i}{n_1}
\]

Next, for the F-test, the following test value is calculated:

\[
T_V = \frac{s_2^2}{s_1^2}
\]

with

\[
T_V = \frac{s_1^2}{s_2^2}
\]

and compared with the value taken from the F-table for

\[
f_1 = f_2 = n - 1 = 9.
\]

Results
If \( T_V < F_{9,9,0.05} \), then the difference between variances \( s_1^2 \) and \( s_2^2 \) is not significant.
If \( T V \geq F_{\alpha, m, m_0} \), then the difference between variances \( \hat{s}^2 \) and \( \hat{s}_0^2 \) is significant.

**Linearity Test**

For this test, use the first injection of all calibration points. The following equations are used:

**The linear calibration equation**

\[
y = a + b \cdot x
\]

where:

\[
b = \frac{\sum[(x_i - \bar{x})(y_i - \bar{y})]}{\sum(x_i - \bar{x})^2}
\]

\[
a = \bar{y} - b \bar{x}
\]

**Standard deviation:**

\[
s_y = \sqrt{\frac{\sum(y_i - \bar{y})^2}{N - 2}}
\]

where:

\[
\bar{y} = a + bx_i
\]

**Process standard deviation:**

\[
s_{\sigma y} = \frac{s_y}{b}
\]

**Relative process standard deviation:**

\[
V_{\sigma y} = \frac{s_{\sigma y}}{100\%}
\]

**Coefficient of correlation:**

\[
r^2 = \left( \frac{\sum(x_i - \bar{x})(y_i - \bar{y})}{\sqrt{\sum(x_i - \bar{x})^2 \sum(y_i - \bar{y})^2}} \right)^2
\]

**The quadratic calibration equation**

\[
y = a + b \cdot x + c \cdot x^2
\]

where:

\[
a = \frac{(\sum y_i - b \sum x_i - c \sum x_i^2)}{N}
\]

\[
b = \frac{Q_{xy} - cQ_x}{Q_x}
\]

\[
c = \frac{Q_{xy}Q_x - Q_xQ_{x,y}}{(Q_x)^2 - Q_xQ_x}
\]

\[
Q_{xy} = \sum s_i^2 - \left( (\sum s_i)^2 / N \right)
\]

\[
Q_x = \sum \frac{x_i^2 - (\sum x_i)^2 / N}{N}
\]

\[
Q_{x,y} = \sum \frac{(x_i - \bar{x})(y_i - \bar{y})}{N}
\]

**Standard deviation:**

\[
s_y = \sqrt{\frac{\sum(y_i - \bar{y})^2}{N - 3}}
\]

**Sensitivity:**

\[
E(x) = b + 2cx
\]

**Process standard deviation:**

\[
s_{\sigma y} = \frac{s_y}{E(x)}
\]
Method Validation

Relative process standard deviation

\[ V_{10} = \frac{s_{10} \times 100\%}{X} \]

F-test

For the F-test, the following test value is calculated:

\[ DS^2 = (N - 2)s_1^2 - (N - 3)s_2^2 \]

\[ TV = \frac{DS^2}{s_{10}^2} \]

This value is compared with the value obtained from the F-table for

\[ f_1 = 1 \text{ and } f_2 = N - 3 \]

Criterion:
If \( TV < F_{\alpha,5%,N} \), then the difference between \( DS^2 \) and \( s_{10}^2 \) is not significant. The calibration may be regarded as linear in the working range.

If \( TV \geq F_{\alpha,5%,N} \), then the difference between \( DS^2 \) and \( s_{10}^2 \) is significant. The calibration is not linear in the working range.

Chapter Nine

Control Charts

1. Overview of Control Charts Software

<table>
<thead>
<tr>
<th>Label</th>
<th>Control Value</th>
<th>Lower Control Limit</th>
<th>Upper Control Limit</th>
<th>Chart Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>A0</td>
<td>50.27</td>
<td>49.84</td>
<td>50.69</td>
<td>1000.GTT 14.06.39</td>
</tr>
<tr>
<td>A1</td>
<td>50.19</td>
<td>49.76</td>
<td>50.62</td>
<td>1000.GTT 15.06.46</td>
</tr>
<tr>
<td>A2</td>
<td>50.17</td>
<td>49.74</td>
<td>50.60</td>
<td>1000.GTT 16.06.53</td>
</tr>
<tr>
<td>A3</td>
<td>50.20</td>
<td>49.77</td>
<td>50.63</td>
<td>1000.GTT 17.06.60</td>
</tr>
<tr>
<td>A4</td>
<td>50.18</td>
<td>49.75</td>
<td>50.61</td>
<td>1000.GTT 18.06.67</td>
</tr>
<tr>
<td>A5</td>
<td>50.23</td>
<td>49.80</td>
<td>50.68</td>
<td>1000.GTT 19.06.74</td>
</tr>
<tr>
<td>A6</td>
<td>50.21</td>
<td>49.79</td>
<td>50.67</td>
<td>1000.GTT 20.06.81</td>
</tr>
<tr>
<td>A7</td>
<td>50.26</td>
<td>49.82</td>
<td>50.69</td>
<td>1000.GTT 01.06.88</td>
</tr>
<tr>
<td>A8</td>
<td>50.42</td>
<td>49.90</td>
<td>50.94</td>
<td>1000.GTT 02.06.95</td>
</tr>
</tbody>
</table>

The Control Chart window

The Control Charts software monitors precision and accuracy of a defined data set.

The software supports four Control Chart types:

- Mean Value Control Charts
- Recovery Control Charts
- Blind Value Control Charts
- Spanwidth Control Charts

Each Control Chart type may be used to create Control Charts for different working ranges and analysis methods.

Control Charts are valid for a specific period of time, after that, a new Control Chart must be created.

The limits for a new chart are copied from the previous Control Chart of the same working range and analysis method.

For each Control Chart, a file is created which contains general information about the type, data structure and other global data. This file also contains all data required
Control Charts

for sample identification as well as data required for display and calculation of the entire Control Chart.

Note: Once samples are added to a Control Chart, they cannot be deleted.

Either select Control Charts from the Tocotr program folder or select Control Charts from the TOC Control Validation menu.

2. File Menu

New

The New command opens a sub-menu from which one of the file types described below is selected.

Select any of these options to open the Open dialog box. To create a new Control Chart, enter a new name in the File Name text box, then select OK.

When OK is selected in the Mean Value, Blind Value, or Spanwidth Control Chart Open dialog boxes, the following Control Chart Options dialog box is displayed. When OK is selected in the Recovery Control Chart Open dialog box, the Recovery Control Charts Option dialog box opens first. Fill in that dialog box as described on p. 172, then click OK to open the Control Charts Options dialog box shown below.

Filename
The file name and path displays in the non-modifiable filename field.

Previous Control Chart
The name of the control chart previously used to track this data displays in the non-modifiable Previous Control Chart field.

Initial Date
The date the control chart was created displays in the non-modifiable Initial Date field.

Date of Last Entry
The date which the control chart was last modified displays in the non-modifiable Date of Last Entry field.

Chart ID
Enter a brief description of the control chart in the Chart ID text box.
Control Charts

User
Enter the name of the user of this control chart in the User text box.

Mean Value Control Chart
The Mean Value Control Chart (.ccm extension) checks the accuracy of an analytical method on an instrument. In some special cases this chart can be used to detect system errors. For example, when using certified standard for the control samples over a long period of time, control value drifts indicate a change in system performance.

Recovery Control Chart
The Recovery Control Chart (.ocr extension) tests an analytical method for matrix influences and provides a restrictive control of accuracy by testing proportional system errors. We recommend using certified standards for Recovery Control Charts, which will test the accuracy of the system as well as the recovery rate.

Recovery Control Chart Options Dialog Box
The Recovery Control Charts dialog box, shown below, opens when File/New/Recovery Control Chart is selected to open the Open dialog box, then OK is pressed.

Using the radio buttons, select either Certified Standard or a Real Sample as control samples.

Certified Standard
When using certified standards, choose between standards with fixed or variable carbon contents. For a fixed content standard, verify that the standard will be available for the entire time the Control Chart is valid.

If using a fixed concentration, select Fixed Theoretical Concentration and enter the concentration of this standard in the text box below.

To use standards with variable amounts of carbon, do not select Fixed Theoretical Concentration. Enter the standard concentration in the Setup Control Tracking Setup dialog box, accessed by selecting Validation/Setup Control Tracking in the TOC Control application.

Real Sample
When using real samples as control samples, process them in two different ways.

a) For samples spiked with a fixed concentration of carbon, select Fixed Concentration of the Spike Component and enter the spiked content in the text box.

b) For control samples with different spiked amounts, enter the spiked content under Setup Control Tracking on the Validation menu in the TOC Control program.

Blind Value Control Chart
The Blind Value Control Chart (.cbb extension) is a special form of the Mean Value Control Chart used for quality assurance of the instrument and variable elements.

This Control Chart can be used with analytical methods where the blind value is different from zero and normally distributed, i.e., BOD, COD-determination and special photometric methods. Here, the control sample is the blind sample for the respective analytic method.

Unlike the mean value Control Chart, the control value is the information value (absorbance, peak height, peak area) received from the analysis.

Spanwidth Control Chart
The Spanwidth Control Chart (.css extension) tests the precision of an analytical method and monitors the
accuracy under actual conditions (Drift Control). For this type of Control Chart, there are several existing models for calculating the control and warning limits.

We recommend calculating only the upper control limit; defining the upper exclusion limit is optional. The lower control limit is zero during measurement of multiple determination with up to six samples.

**General Parameters dialog box**

This dialog box opens when OK is selected on the Control Chart Options dialog box. Enter additional information and parameters for the new Control Chart in this dialog box.

**Max. Number of Samples in Pre-Period**

In the Max Number of Samples in Pre-Period text box enter the number of samples to be used for the preparation period. This value is important because the samples are used to calculate the limits (upper and lower warning limit, upper and lower control limit) after all samples of the preparation period are added to the Control Chart. The default value is 12.
Following CC

Select this menu item to create the Following Control Chart.

![The Following Control Chart dialog box]

Previous Control Chart

When a Control Chart is already loaded, the file name is added automatically to this dialog box. The BROWSE button can be used to locate a different file.

New Control Chart

Enter the file name of the Following Control Chart in the Edit field. The BROWSE button is used to select a directory where the new Control Chart will be saved.

Create

Press CREATE to read the data of the previous Control Chart and calculate the new limits from the samples of the control period stored in the previous Control Chart.

Show Parameters / Show Options / Show Limits

After creating the new Control Chart, the SHOW PARAMETERS, SHOW OPTIONS, and SHOW LIMITS buttons are enabled. Use them to view information on the created Control Chart.

Press OK to save the new, empty Control Chart under the assigned file name in preparation for use.

Open

Select Open to access the Open dialog box. Use this dialog box to open an existing Control Chart.

Save

Choose Save to save the current data. If the data has not been saved previously, the Save As dialog box opens.

Save As

Choose Save As to open the Save As dialog box. Use this dialog box to save the current data to a new file name or location.

Printer Setup

Select Printer Setup to open the Printer Setup dialog box. Options will vary depending on the system printer.

Print

Select Print to print the current control chart.

Close

Exits the Control Charts program.

3. View Menu

These menu items are used to display the features and parameters of the Control Charts.
on the graph. When the left mouse button is released, new information is displayed in the header.

The Graph display

Statistics

Select Statistics to display information relevant to the loaded Control Chart. Select OK to close the dialog box.

Type

Type displays the type of Control Chart currently open (Mean Value, Recovery, Blind Value, or Spanwidth).

No. of Samples for the Prep. Period

No. of Samples for the Prep. Period displays the number of samples used for the preparation period. This number was set when the chart was first created. For Following Control Charts, this number will always be zero.

Total No. of Samples

Total Number of Samples displays the total number of sample entries. The total includes samples used during the preparation and control periods.

Mean Control Value

The Mean Control Value is the average control value calculated from all samples of the preparation period. This value is calculated from the samples in the preparation period or, for a new
chart, carried over from the control period of the previous Control Chart.

**Upper/Lower Control Limits and Upper/Lower Warning Limits**

The Upper and Lower Control Limits and Warning Limits are the calculated limits of the current Control Chart. The values are calculated from the samples in the preparation period or, for a new chart, taken from the control period of the previous Control Chart.

**Upper/Lower Exclusion Limit**

The displayed values are set during the creation of the Control Chart. They must not be changed during the lifetime of a Control Chart system.

**Mean Control Value / Standard Deviation / Coefficient of Variation**

The Mean Control Value, Standard Deviation, and Coefficient of Variation are calculated from all samples of the control period (except excluded samples), and are updated with every new data addition. The difference between this mean value and the mean value stored in the Control Chart shows long-term changes of the control samples during the lifetime of the Control Chart.

**Comparison Between Control Charts**

After finishing a complete Control Chart, the current results of the control period must be compared with the results from the preparation period. For Control Charts without a preparation period, the current values must be compared with the results of the preparation period taken from the previous Control Chart.

Enter the file names of the Control Charts or use the BROWSE button to locate the files. When there is a Control Chart open, the file names are automatically entered from that chart.

Select COMPARE to begin the statistical comparison. The following two methods are used to check long-term deviations in the Control Chart.

**Mean Value T-Test**

The mean values and variances are calculated from the control and preparation period. Then a test value is calculated and compared with the corresponding value from the T-table. This comparison shows whether the long-term deviation of the control samples is significant.

The equations are:

\[ TV = \frac{\bar{x}_1 - \bar{x}_2}{s_x} \sqrt{\frac{N_1 N_2}{N_1 + N_2}} \]

with:

\[ s_x = \sqrt{\frac{(N_1 - 1)s_1^2 + (N_2 - 1)s_2^2}{N_1 + N_2 - 2}} \]

for: \( N_i = N_i \), \( f_i = f_j ; f = 2N - 2 \)

Criterion:

\( TV \leq t(f, P = 95\%) \): deviation is not significant
\( TV > t(f, P = 95\%) \): deviation is significant
Control Charts

Testing the Homogeneity of Variance

This test is performed exactly like testing the homogeneity of variance during Method Validation. See the section on Validation (p. 165) for the equations.

List Out of Control Events

After adding new control samples to the control period of a Control Chart, the control value is compared with the defined limits. Several events can occur which show that there are long-term changes in the analytical performance of the instrument. When an Out-of-Control event occurs, the instrument has to be checked for system errors. After fixing the problem, re-calibrate the instrument and perform Method Validation again.

During measurement, a message is recorded each time an Out-Of-Control event occurs. In this message box, all Out-Of-Control events are listed which occurred during the lifetime of the current control period.

The following Out-of-Control Events can occur during the lifetime of a Control Chart:

- One control value exceeds the control or exclusion limits
- Two out of three control values exceed the warning limits
- Seven consecutive control values are above or below the mean control value
- Seven consecutive control values show an increasing or decreasing tendency

![The Out of Control Events dialog box](image)

- Note: When an Out of Control Event or an error occurs during data addition, a message is displayed in the Message Log.

4. Options Menu

The Options menu items are used to set parameters for different features of the Control Chart software.

![The Options menu](image)

Display Font

Select Display Font to open the Font dialog box. Use this dialog box to select a new screen font. See Printer Font, p. 62, for more information on the Font dialog box.

![The Display Font](image)

General Parameters

The General Parameters dialog box displays the parameters for the current Control Chart. Some items cannot be changed after the Control Chart is created.
Max. Number of Samples in the Preparation Period
The Max Number of Samples in the Preparation Period displays the number of samples used for the preparation period. These samples are used to calculate the limits (upper and lower warning limit, upper and lower control limit) after all samples of the preparation period are added to the Control Chart. This field is modifiable. The default is 12.

Max. Number of Samples in the Control Period
The Max Number of Samples in the Control Period field displays the maximum number of samples in the Control Chart. This field is modifiable. The default is 90.

Control Chart Type
The Control Chart Type field displays the current type of Control Chart.

Working Range
In the Working Range text box enter the working range for the current Control Chart, e.g., 10 – 100 ppm. The range should correlate with the concentration of the samples used for control tracking and also with the concentration range of the used calibration curve. To check the linearity of the calibration, see the section on Validation (p. 155).

TOC Method
The TOC Method displays the analysis type (TC, IC, etc.) for this Control Chart. During data addition, only samples of the specified analysis type are added to the Control Chart.

> Note: When the Message Log displays “Checking Controls” and the analysis type does not match, an error message is added to the Message Log.

Unit
Displays the unit of measurement. Ensure that only samples of the same units are added to the Control Chart.

Exclusion Limit (%)
This value defines the upper and lower exclusion limit of the Control Chart. This limit is only defined once and cannot be changed with the recalculation of the other limits.

No of injections (Spanwidth Control Chart only)
For the Spanwidth Control Chart, it is recommended that only control samples with the same number of replicates be used, as that value defines this number. However, the control sample is added to the Control Chart even when the number of replicates differs.

Parameter / Measuring Method / Matrix
Enter common parameters for sample conditions, sample origin, and sample matrix.

Control Chart Options
Common parameters for the current Control Chart are displayed in this dialog box. Fields that cannot be changed after a Control Chart is created are dimmed.
The Control Charts Options dialog box

File name
The file name and location of the current Control Chart is displayed.

Previous Control Chart
The file name of the previous Control Chart is displayed.

Initial Date / Date of Last Entry
The Initial Date and Date of Last Entry display the current system date when a new Control Chart is being set up. When a saved Control Chart is open, the relevant dates are shown.

Chart ID
Enter an identification for the Control Chart.

User
Enter the name of the user.

Recovery CC Parameters
The items in this dialog box display the same parameters as those when the new Control Chart was created. Fields that cannot be changed after a Control Chart is created are dimmed.
General Parameters
Select General Parameters to print the information displayed in the General Parameters dialog box. This dialog box can be viewed by selecting Options/General Parameters.

ASCII Export Options
Select a separator from the drop-down list. During ASCII export, items of information are separated by the selected separator. When importing the ASCII file into another program, the separator used must be specified.

ReCalc Limits
After excluding samples from calculation, select this menu item to recalculate the limits of the current Control Chart.

Enable Exclusion
When a check mark is displayed next to this menu item, exclusion is enabled. When control samples are excluded, they are not used for calculations or the determination of Out-of-Control events.

Note: Add a comment regarding the reasons for the exclusion in the Control Chart.

Save Settings on Exit
When a check mark appears next to this menu item, all program settings are saved when the program is closed.

5. Help Menu
Content
Select Content to open the table of contents for the Help file.

About
Select About to view software registration and version information.
Chapter Ten

Program Check

To ensure data integrity, this auxiliary program checks whether any program files have been modified.

Select the Program Check item from the Toenctr folder. This opens the Check the Program Files window.

Ensure data integrity with the Program Check

Select EXECUTE to perform the check. When the check is finished, the results will be displayed in the window. For details on the check, select NOTEPAD.
Chapter Eleven  Verification

The TOC Control software supplies verification data so the operator can verify that the software is working correctly and that data is being processed correctly.

The verification files are listed below:

<table>
<thead>
<tr>
<th>File Name</th>
<th>File Size (KB)</th>
<th>Date Stamp</th>
<th>Time Stamp</th>
</tr>
</thead>
<tbody>
<tr>
<td>VAL_TEST.PKT</td>
<td>29,496</td>
<td>11-07-97</td>
<td>16:37</td>
</tr>
<tr>
<td>VAL_TEST.MST</td>
<td>310</td>
<td>11-07-97</td>
<td>15:13</td>
</tr>
<tr>
<td>VAL_TEST.CAL</td>
<td>353</td>
<td>11-07-97</td>
<td>16:51</td>
</tr>
<tr>
<td>VAL_TEST.TOC</td>
<td>1,122</td>
<td>11-07-97</td>
<td>16:58</td>
</tr>
</tbody>
</table>

These files are available on Disk 3 of the program installation disks. Create a directory for the files (e.g. \tocnt\test), then copy the files to the directory.

Verification Procedure:
1. Start the TOC Control program.
2. From the File menu, choose Open, and open the "val_test.toc" file.
3. Select Attach Data File from the File menu, and choose the "val_test.pkt" file. This enables the program to locate the Peak Profile data of the analyses.